
About The Seed Program
Select About The Seed Program from the Help menu to display a screen showing the 
program title, version number, copyright notice and the address for CyberNiche 
Software.    The is also a button that will allow you to print an order form for purchasing 
the registered version of the program.



Add Another
The Add Another button allows you to quickly add a number of new records to the 
program's database.    The Add Another button is only displayed while adding a record. 
Clicking on this button will save the information for the record you have just entered and 
immediately begin adding another record.    It is equivalent to clicking the Update button, 
and then clicking the Add New button again.



Adding New Seeds

Click on the Add button to add a new new seed record to the database.    A window will 
be displayed showing all of the Crops that are defined in the program's database.    Click 
on the appropriate crop for the type of seeds you wish to add so that the crop name 
appears highlighted, then click on the Ok button.    Click on the Cancel button if you 
change your mind and do not wish to add a new seed record.    If the crop you want is 
not listed, you will have to add a crop record for it first (see Crop Maintenance).

Note: the evaluation version of the Seed Program has a limited number of crop 
information records available.    Register your copy of the program to receive 
approximately twice the number of predefined crop records.    (You are also limited to 
creating no more than five seed records in the evaluation version.)



Cancel
The Cancel button is only displayed while adding a new record or modifying an existing 
record.    Click on this button if you change your mind and do not want to update the 
program's database file with the new information you have just entered.

If the Cancel button is no longer displayed, you will need to click on the Delete button to 
remove the currently displayed record.



Changing Frost Dates and Year

Select Change Frost Dates and Year from the File Menu to enter the specific frost 
dates for your particular area.    These dates are used by the program for calculating the 
proper planting dates for your area.    When you first run the program, the frost dates for 
the author's home in Central Pennsylvania will be shone.    You will need to change 
these dates unless you live in a very similar climate. 

Your local County Extension Office (for gardeners in the United States) will be able to 
tell you the last and first frost dates for your area.    You may also refer to gardening 
reference books, ask other gardeners or go by your own experiences if you have 
already been gardening in your current location for a few years. 

The Current Year field indicates the year for which planting dates are calculated and for 
which the Planting Schedule is printed.    The first time you run the program during a 
new calendar year, the program will ask if you wish to automatically update the 
database to the new year.    If you wish to change the active year at any other time, you 
may do it here.

To modify the frost dates, click on the month, day or year of the date you wish to change 
and then enter the appropriate numbers or click on the up or down arrows next to the 
date.    Click on the downward pointing arrow at the far right to display a pop up calendar 
from which you can select a new date.

When you make any change to the frost dates or year, buttons are displayed that allow 
you to save your changes or cancel and return to the seed maintenance screen without 
making any changes.    If you click on the button to save your changes, all of the 
planting dates for seed records that you have created will be updated to reflect your 
changes.



Compacting the Database
Select Compact Database from the File menu to compress the Seed Program's 
database file and recover disk space from deleted records.    This is an optional 
procedure that you may safely ignore.    Unless you have actually deleted a number of 
crop or seed records from the program's database, you will not see any changes in the 
size of the Seed Program's database file (SEEDS.MDB).

Note:    you should close all windows other than the main seed maintenance window 
before compacting the database so that the other windows will not lock the database 
file.



Contents -- The Seed Program
General Information

Overview
Copyright and Disclaimer
Differences Between Evaluation and Registered Versions
Order Form
How to Contact CyberNiche Software
Terms Used: Fields and Records
Crop Records and Seed Records
Setting the Frost Dates

Maintaining Seed Records
The Main Seed Maintenance Screen
Adding New Seeds

Update
Cancel
Add Another

Deleting Seed Records
Navigating Existing Records
Finding a Seed Record
Maintaining Crop Records

Seeds Data Fields
Crop Name
Variety Name
Seed Source
Number of Seeds
Reorder Amount
Year Packed
Planting Times
Growing Hints
Notes
Days to Germinate
Days to Maturity
Plant Spacing - In Row
Plant Spacing - After Thinning
Plant Spacing - Between Rows
Plant Spacing - Intensive Spacing
Planting Depth

File Menu Options
Changing Frost Dates and Year
Importing Data from MS-DOS Version
Compacting the Database
Exiting From The Seed Program
The Crops Menu and Maintaining Crops



Report Menu Options
Viewing or Saving Reports
The Planting Schedule
Inventory Reports
Report Output Window

Help Menu Options
Getting Help
About The Seed Program



Copyright and Disclaimer
The Seed Program is copyrighted 1995, 1997 by Michael Wolter.    All rights 

reserved. It is not public domain nor free software. Non-registered users are granted a 
limited license to use the demonstration version of this product on a trial basis. If you 
intend to use The Seed Program on a regular basis, you are expected to register. For 
information on registration, see the Order Form.

A registered user is granted a single-user license to use this program on any one 
machine at any one time. A registered user is permitted to make a copy of the program 
for backup purposes only.    Distribution of the registered version of the program is not 
permitted under any conditions.    The shareware or evaluation version of the program 
may be copied and distributed without restriction as long as all the original files are 
included and are not modified in any way.

Trial Users of The Seed Program must accept this disclaimer of warranty: 
The Shareware evaluation (trial use) version is provided AS IS. The author 

makes no warranty of any kind, expressed or implied, including without limitation, any 
warranties of merchantability and/or fitness for a particular purpose. 

Registered Users of The Seed Program must accept this disclaimer of warranty:
The author warrants the physical disk(s) provided with registered versions to be 

free of defects in materials and workmanship for a period of ninety days from the date of 
registration. If the author receives notification within the warranty period of defects in 
materials or workmanship, and such notification is determined by the author to be 
correct, the author will replace the defective disk(s). 

The entire and exclusive liability and remedy for breach of this Limited Warranty 
shall be limited to replacement of defective diskette(s) and shall not include or extend to 
any claim for or right to recover any other damages, including but not limited to, loss of 
profit, data, or use of the software, or special, incidental, or consequential damages or 
other similar claims, even if the author has been specifically advised of the possibility of 
such damages.    In no event will the author's          liability for any damages to you or any 
other person ever exceed the lower of suggested list price or actual price paid for the 
license to use the software, regardless of any form of the claim.    The author specifically 
disclaims all other warranties, express or implied, including but not limited to, any 
implied warranty of merchantability and/or fitness for a particular purpose.



Crop Name
The first field on the Seed Maintenance screen is the crop name field.    This is the name 
of the crop that you select from the crop list when you first create the seed record.    You 
cannot change the crop once the record has been created.    The crop is the general 
type of plant (beans, squash or tomatoes) rather than a specific variety name of a 
certain plant.



Crop Records and Seed Records
The Seed Program's database is divided into two types of database records.    Crop 
Information records contain general information on a type of garden crop, such as 
beans or tomatoes.    The program comes with this information already in place for a 
variety of different garden crops.    Seed records contain information on a particular seed 
variety that the user has purchased and entered in the program.    Seed varieties such 
as "Brandywine Tomatoes" or "Dragon Lingerie Beans" are examples of possible seed 
records.    When first installed, the program contains no seed records, since there is no 
way to know what particular seed varieties you have purchased.    When you enter a 
new seed packet into the program, most of the information from the crop information 
database is copied from the crop information database to the seed record.    The 
"growing hints" (text information relating to the crop) is not copied into the seed record 
in order to conserve disk space, but all other information is copied to the seed record 
and may be modified without changing the original crop information record.



Days to Germinate
This field holds the average number of days it takes this type of seed to germinate -- to 
start growing and appear above the surface of the soil.



Days to Maturity
This field stores the number of days to maturity for a seed variety.    The days to maturity 
is usually indicated in seed catalogs or on seed packets.    In most cases, this will be the 
number of days between the time that the seed is planted in the soil and the time when 
the plant or its fruits reach harvestable size.    This information is useful in planning 
planting times and, in areas with a short growing season, is useful in deciding whether 
some crops are appropriate for your area. 

For certain crops that are almost always planted indoors for later transplanting, such as 
tomatoes and peppers, the "days to maturity" number that is recorded is the number of 
days from the time the transplant is planted in the garden until the time of the first 
harvest.    Most seed catalogs follow this convention.



Deleting Seed Records
Click on the Delete button to delete the seed record currently displayed on the screen 
from the program.    A confirmation window is displayed on the screen asking if you are 
sure you wish to delete the current record.    Click on Yes to delete the record.    Click on 
No to return to the seed maintenance window without deleting the current record.



Differences Between Evaluation and Registered Versions
Registered users of The Seed Program receive an upgrade to the latest version 

of the program that includes the full crop information database.    The evaluation version 
contains only a subset of crop information.    The evaluation version is limited to the 
creation of five seed records, while the registered version imposes no limits.    The 
registered version of The Seed Program does not display the registration screen that is 
shown as you exit from the evaluation version.    When the registered version of the 
program is purchased and installed, no information that has already been entered in the 
evaluation version is overwritten.    Any seed information that has already been entered 
is preserved exactly as it is. 



Exiting From The Seed Program
Select Exit from the File menu to close all windows and exit from the program.    The 
evaluation version will display a window with information on how to register the program 
and will allow you to print an order form.    The full version will exit from the program 
without this screen being displayed.



Finding a Seed Record

After you have entered several seed records, you may find it useful to click on the Find 
button to locate a particular variety.    After you click this button, a small window will 
appear where you may enter the first few characters of the variety name you wish to 
locate.    Alternately, since the seed records are sorted alphabetically by variety name, 
you may use the navigation buttons First, Previous, Next and Last to move to the 
information for a certain variety.



Getting Help

Context sensitive help is available throughout The Seed Program.    Just press F1 from 
any window and information will be displayed on the particular part of the program that 
you are currently using.

For more detailed information, use the options on the Help menu.    Select Contents to 
display the complete listing of all topics in the help file.    Select "Search for Help on..." 
to use the standard Windows Help procedure for searching for help on a particular topic. 
Select Using Help for general information on using Help files in Windows.



Growing Hints
The growing hints are advice for planting, growing and harvesting a crop.    The hints 
take the form of text, stored in the crop information database and are displayed in a 
window when you click on the Hints button on the Seeds maintenance screen. 

Use the <Page Down> key to display successive screens of text, and the <Page Up> 
key to go back to view previous screens.    The up and down cursor arrow keys will 
move the text display one line at a time.    Click on the Ok button when you are finished 
viewing the growing hints.    The growing hints can be modified only through the Crop 
Maintenance screen.    The same growing hints are displayed for all seeds of a 
particular crop.



How to Contact CyberNiche Software
You may contact CyberNiche Software by mail, by e-mail or by phone.

CyberNiche Software
4271 Carlisle Rd.
Gardners, PA 17324-8930
USA

e-mail: cniche@pa.net, or wolter@dickinson.edu

Phone: 717-486-8308

Our web site is at:    http://www.pa.net/~cniche/

We will also do custom Windows programming work at reasonable rates.



Importing Data from MS-DOS Version
Note: The standard version of The Seed Program does not include the ability to 
import MS-DOS data.    This prevents unnecessary files from being installed on 
your computer.    You may request the version that can import data from the MS-
DOS version of The Seed Program when you register.    There is no extra charge 
for this version and you do not need to have registered the MS-DOS version to 
request it.

If you have used the MS-DOS version of the Seed Program and have requested the 
version of The Seed Program that can import MS-DOS data, you may select Import 
Data from MS-DOS Version from the File menu to preserve all of the information you 
entered in the MS-DOS version of the program.

Warning: the predefined crop information that comes with the program will be 
overwritten with any changes that you have made to the crop information database.    
No crop records will be deleted and no seed records that you have already created in 
the Windows version will be modified or deleted. 

The program will prompt you with a standard Windows Open File dialogue to indicate 
the location of the crop information database file (CROPINF.DBF) from the MS-DOS 
version.    You should not need to change the filename.    This file may be located in the 
same directory (c:\seeds) that the Windows version is installed in.    Select the proper 
folder for the location of this file and click on Ok.    Click on Cancel if you wish to return 
to the seed maintenance screen without importing any data. 

If you have selected the proper location of the crop file, the program will go through all 
of the crop records from the MS-DOS version database and update the Windows 
database to match.    The program will next attempt to open the MS-DOS version seed 
database file in the same directory or folder and will create new seed records in the 
Windows version database for all the seed records that you had created in the older 
version.    Finally, the program will update all of the planting dates in the imported seed 
records to correspond to the frost dates that you have defined in the Windows version. 
(If you have not yet updated the frost dates in the Windows version, you may do this 
after importing data.)



Inventory Reports

Select one of the Inventory report options from the Reports Menu to generate a report 
listing the seed records you have entered in The Seed Program. 

All Seeds will list all of the seed records that have been entered in the program's 
database without exception.
# Seeds > 0 will include only seed records where you have entered a number in the 
# of Seeds field that is greater than zero.
# Seeds < # Reorder will include only seed records where you have entered a 
number in the Reorder # field and that number is greater than the number in the # of 
Seeds field.

The inventory report will either be displayed in a Report Output Window or a Save As 
dialogue will appear if you have chosen to save reports to text files.



Maintaining Crop Records

Select Maintain Crops from the Crops Menu to make changes to the crop information 
records in the Seed Program's database.    Crop records store the standard information 
for a general type of plant, such as beans or tomatoes.    The crop information displayed 
in this window serves as the default -- when you create new seed records for this crop, 
these values are used to start off your seed record.

Note: only a limited sample of the full crop information database is available in the 
evaluation version of the program.    The registered version that you receive when you 
purchase the program has approximately twice the number of crop information records.

The buttons for navigating crop records, finding a specific record, adding and deleting 
records all function the same way as the they do for Seed Record Maintenance.    
Changes that you make to crop records will have no effect on seed records that you 
have already created, but the new information will be used for any future seed records 
that are created.    Since Growing Hints are not stored separately for each seed record, 
changes you make to the hints will be seen whenever you view hints from a seed 
record.



Navigating Existing Records
If seeds have been added to the program already, and you are not in the middle of 
adding another new seed record, the key navigation buttons will be available.

Click the First button to move to the very first record.    The seed records are sorted 
alphabetically by variety name after they have been entered
Click the Previous button to move to the seed record immediately before the current 
record.    If the first seed record is already displayed, the computer will beep and the 
first record will remain on the screen.
Click the Next button to move to the seed record following the current record.    If the 
last seed record is already displayed, the computer will beep and the last record will 
remain on the screen.
Click the Last button to move to the last seed record in the database.



Notes
Click on the Notes button to view or make changes to your notes for this particular seed 
record.    Use this screen to record any information about this particular packet of seeds. 
Use your notes to keep track of when you planted the seeds, how good the germination 
rate was, how the crop performed, when you harvested the crop or how well you liked 
its flavor.    Any information you wish to remember in connection with these seeds may 
be entered here.

From the notes screen you may use the up and down arrow keys to move the cursor up 
and down a line at a time, or the right and left arrow keys to move right and left a single 
character at a time.    Holding down the control key while you press the right or left arrow 
keys will move the cursor a word at a time. 

Click on the Ok button to save your changes when you have finished entering notes or 
changing the text that you have recorded there.    Click on the Cancel button to discard 
any changes you have just made to your notes.    Warning: canceling out of your notes 
will cause the loss of any newly entered information



Number of Seeds
This is an optional field in which you may enter the number of seeds you have, or the 
number of packets you have for this variety.    If you do not want to bother even making 
a rough estimate of the number of seeds that you have, just leave this field empty.

This number can be used along with the reorder amount (the following field) to obtain a 
list of the seeds that you need to buy or reorder.    This option of the inventory report will 
list all of the seed varieties for which the number in the "# of Seeds" field is less than the 
number in the "Reorder:" field. 



Seed Program Order Form
To order, call 717-486-8308 or select Print Topic from the File menu to print this order 
form and mail to:

CyberNiche Software 
4271 Carlisle Rd.
Gardners, PA 17324-8930

Date: ____________ Ref No: SP200-1000

Name: ________________________________________________

Address: ______________________________________________

                                  ______________________________________________

                                  ______________________________________________

Phone:          ______________________________________________

E-Mail:          ______________________________________________

Where did you hear about the program? _______________________

What version of Windows do you use? ________________________

Registration Fee: $25.00 per copy
Shipping & Handling: $    3.00 per order
PA residents add 6% Sales Tax ($1.68 for one copy)
Outside of the US, add $1.50

*Checks must be payable in US dollars and drawn on a US Bank*

Circle one:      Visa      Mastercard      Check      Money Order

Card #: ___________________________________

Exp. Date: ___ / ___

Signature: _________________________________



Overview
The Seed Program is a database system for garden seeds.    Use it to help organize 
your seeds -- keep track of what seeds you have purchased, where they are from, how 
old they are and what seeds you need to buy.    The program will print a planting 
schedule for the seeds you have entered, so you know exactly when and how to plant 
all of your seeds.    The database includes extensive information for a wide variety of 
vegetable and herb seeds.    Available information includes proper planting procedure, 
care for the crop, organic methods of combating pests and diseases, and the proper 
harvest and storage of the crop. 

The Seed Program can also serve as a garden journal for you to enter notes about your 
experiences with specific varieties of garden crops.    In addition to the planting 
schedule, a variety of reports are available to allow you to access the information 
supplied with the program or the information that you enter.    In general, reports can be 
displayed on the screen, sent to your printer or sent to a file on disk.    The Seed 
Program is designed to be easy to use, for gardeners with any level of computer 
experience.    Context sensitive help is available throughout the program.



Plant Spacing - After Thinning
This is the distance that should separate full grown plants grown in traditional rows.    
This spacing will give the plants sufficient room to grow when they have reached full 
size.    Many crops are traditionally planted closer together when the seed is first placed 
in the soil, and later "thinned" to the proper distance by some plants being pulled out 
and discarded.    This procedure of planting seeds close together and later thinning 
prevents gaps from appearing if some seeds fail to germinate. 



Plant Spacing - Between Rows
The distance (in inches) that should separate rows of a crop, when it is being grown in 
traditional rows (as opposed to "wide beds").    This distance should be sufficient to 
accommodate the size of the fully grown plants.    In some cases, you may want to 
adjust this distance to take into account the width of a rototiller or other method of 
cultivation.



Plant Spacing - In Row
This field shows the distance apart (in inches) that seeds should be planted when they 
are being planted in traditional rows.    In many cases, this distance will be closer than 
the final separation distance of the full grown plants, and the plants will need to be 
thinned after they have begun to grow. 



Plant Spacing - Intensive Spacing
These two fields ("Plants / Sq. Feet") are used to show the proper plant spacing when 
using "intensive" or "wide bed" growing techniques, rather than the traditional single 
rows.    This style of gardening is also sometimes called "square foot gardening." 

The idea of this gardening method is that traditional single rows are designed more for 
commercial agriculture than for the home gardener.    Traditional single rows and 
spacing may leave room for tractors and other mechanical equipment.    The gardener 
who will be cultivating with nothing more cumbersome than a hoe can successfully plant 
crops much closer together.    This leads to a more efficient use of space (more produce 
from the same sized bed), less weeding and less watering.

Usually, this spacing is expressed in a certain number of plants per square foot.    In this 
case, the first field shows the number of plants that can be grown in a single square 
foot.    Some bulky crops, such as some squash, will require more than a single square 
foot, in which case a "1" is entered in the first    field and the second field is used to 
indicate the number of square feet that are needed for a single plant.



Planting Depth
This field shows the proper planting depth for seeds in inches.    This should be 
considered an average planting depth.    Gardeners may wish to plant seeds deeper in 
warm, dry weather to conserve moisture.



Planting Times

The fields in this section of the seed maintenance window are used to record the 
planting times for the seed you have selected.    The four rows represent four types of 
seed planting that are most often used for various crops: 

Spring Inside - used for seeds that are started indoors and later transplanted
Transplant - for the date that plants are transplanted out in the garden after having 
been started indoors
Spring Outside - for seeds that are planted directly outside
Fall Outside - for seeds that are planted in the fall or late summer rather than the 
spring or late winter

The first three of these planting times are associated with the last frost date in the 
spring.    The Fall Outside planting line is associated with the first frost date that occurs 
in the fall.

Each of these four planting times have three fields of database information that are 
associated with them.    The "Before/After Frost" field indicates whether the seed should 
be planted before or after the frost date.    Click on the Before or After option button to 
select the correct planting time.    If you change your mind and wish to remove the 
selected option, click to select it and then press the Backspace or Delete buttons on 
your keyboard.

The "Planting Week" field stores the number of weeks before or after the frost date that 
the seed should be planted.    When you enter a week number and click on a Before or 
After option button, the program uses this information, along with the frost dates you 
have entered, to calculate the correct planting date.    This date is always a Sunday, 
since the planting schedule is organized on a weekly basis.    Planting dates are always 
approximate, and will change slightly from year to year depending on the weather, so 
the planting week provides the correct level of detail.    The third field "Appear on 
Schedule" indicates whether the current seed variety should actually be printed on the 
planting schedule for the date displayed.

For most crops, all four lines are not used.    An example may be helpful: tomatoes are 
typically started indoors and later transplanted into the garden.    For tomatoes, the first 
two planting date lines would be used: "Spring Inside" and "Transplant."    Tomatoes, 
needing a long growing season, cannot be planted directly outdoors in most climates, 
and cannot be grown as a fall crop, so the third and fourth lines would be left blank.    
Carrots are not started indoors and transplanted because of their long tap root, so the 



first two lines would be left blank.    Carrots can be planted as either a spring or fall crop, 
so the third and fourth lines could both be used for carrots. 

When you create a new seed record and select a crop name from the list, 
recommended planting times and dates from the crop database are automatically 
provided.    This information can be changed as you enter the seed record.    The 
planting times provided with the program are intended only as general advice, since 
gardeners often have strong individual preferences.    Some gardeners start growing 
their tomatoes just a few weeks before planting so that young, actively growing plants 
can be placed out in the garden.    Other gardeners start tomatoes during the winter and 
transplant them several times indoors in order to have large, robust plants to transplant 
into the garden when the weather warms.    Such gardeners will want to customize The 
Seed Program by modifying the planting dates.    The suggested planting dates that 
come with the program will be most useful to beginning gardeners, or to gardeners 
trying out new crops.



Reorder Amount
This optional field contains the "reorder amount."    The "Inventory - # Seeds < # 
Reorder #" report will allow you to produce a list of seed varieties for which the reorder 
amount is higher than the seed count. This field may be left blank. 



Report Output Window

The Report Output Window is the standard screen where all reports are displayed.    
The scroll bar on the far right will allow you to select different pages, if the report is 
longer than one page.    The Print button will print the report that is currently displayed. 
The Ok button will close the Report Output Window. 

The horizontal scroll bar at the bottom (next to the binoculars) is the zoom control.    The 
zoom control allows you to enlarge or reduce the size of the report on the screen.    
Reduce the report size in order to see an entire page on the screen at one time.    
Enlarge the report size in order to read the details of the report.    If the report is 
enlarged to a size that will not fit in the window, scroll bars will appear immediately next 
to the report text to allow you to view the entire report.

Click on the Print button to print the report that is currently displayed on the screen.    
When you have finished viewing or printing the report, click on the Ok button to close 
the Report Output window.    You will return to the Seed Maintenance window, where 
you may continue with other work.



Seed Source
Enter the name of the source that you obtained the seeds from.    This may be the 
company that packaged the seeds, the mail order company that the seeds were ordered 
from, or just the name of the person who gave you the seeds.



Setting the Frost Dates

One of the first things you should do when starting to use The Seed Program is to set 
the correct last and first frost dates for your particular area.    See Changing Frost Dates 
for detailed instructions.    The program is shipped with the proper frost dates for the 
author's home in South Central Pennsylvania, but your region's dates will probably be 
different.



Terms Used: Fields and Records
In explaining the use of The Seed Program in this documentation, two general database 
terms are widely used: "fields" and "records".    A field is a single piece of information 
stored in a standard way.    The planting depth of a seed, represented as a number of 
inches, is a piece of information that the program stores for every crop in the database. 
This value is an example of a field.    A record is made up of a collection of fields.    A 
seed information record contains a number of different fields, including variety name, 
seed source, year purchased and many more.



The Main Seed Maintenance Screen

When the program is first started, the Seed Maintenance window will be displayed.    
The Crop Name, Variety Name, and a number of other data fields are displayed on this 
screen.    The first time the program is run, these fields will all be blank, since no seed 
records will have been created yet.    Click on Add New to start entering your seeds in 
the program.

Buttons on this window allow you to view Growing Hints, enter Notes for the current 
seed variety, move to different seed records and Add or Delete seed records.    The Help 
button will display the program documentation that you are now reading.



The Planting Schedule

Select one of the Planting Schedule options from the Reports Menu to generate a 
planting schedule report based on the planting dates for the seed records you have 
entered in the program.    The "Names Only" report will include columns for the planting 
week, what type of planting should be performed (inside, outside or transplanting) and 
the crop and variety name of the seeds to be planted.    The "Names and Directions" 
report will include this information in addition to the planting information from the crop 
record (spacing, depth, etc.).

A window will be displayed where you may select the period of time that you are 
interested in.    Click on Ok to accept the default dates and generate a schedule for the 
entire year, or click in the date fields and change these dates to narrow the planting 
schedule to a shorter period of time.    Click on Cancel to return to the seed 
maintenance window without generating a schedule.

The planting schedule will either be displayed in a Report Output Window or a Save As 
dialogue will appear if you have chosen to save reports to text files.



Update
The Update button is displayed only when adding a new record or modifying an existing 
record.    Clicking Update will save the newly entered or changed seed record to the 
program's database file and allow you to continue with other work.



Variety Name
Enter the name of a particular variety of seeds in this field.    For example, "Red Sails" is 
a variety of Lettuce.    This field may be left blank if the variety is unknown or if the seeds 
are not for a named variety.    You may change the variety name at any time just by 
entering a new name in this field. 



Viewing or Saving Reports

The first two options on the Reports Menu allow to to choose whether reports are 
displayed with the option to print or whether the report information is saved as an text 
file.    By default, reports will be displayed in a Report Output Window, where you can 
examine the different pages of the report on the screen or click on a button to print the 
report.    The first menu option ("View/Print Reports") is checked to indicate that this is 
the default setting.

Select the second Reports menu option to save the contents of reports to a text file.    
The check mark will be displayed next to this option after you select it.    When the "Save 
Report to Text File" option is checked and you run one of the reports, a standard 
Windows Save As dialogue window will be displayed.    Click on Ok to use the default 
filename that is shown, or enter an alternate name and/or folder.



Year Packed
Enter the year that the seeds were packed for.    This information will help you keep 
track of the age of your seeds, so you will know which seeds should be used up soon, 
and which seeds should probably be replaced because they are too old.    The year 
entered in this field will usually be the current year, so the program will automatically 
place the current system year in this field.    If you need to enter a different year, you 
may double click on this field so that the year listed there is highlighted and then type 
the new year to replace the displayed year. 






